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Database Management

eAttribute Data

eEntering and Coding Attribute data

eLinking Digital Map and Attribute Information
eDatabase and Database Management System

eRelational Database structure
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Attribute data

-location , various descriptions of the object and dating

m Ildentity : building number
" o asm Location: Address
He - " Representative coordinates

]

o Description: Builder/owner

" Status
"a Type
Function
. water Supply
ey Available area
Date: Year built

Attribute data
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Entering and Coding Attribute data

-Establish an ID code between geometry and
attribute

-Conserve computer memory
-Ease Input work

-Simplify the searches for data

ID ID

coordinates Location

Topology Description
ceometry Dating

Attribute



Entering and Coding Attribute data
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100

200

Built-up

110

120

210

220

230

Industry

Transportation

Coniferous

Decedious

111
112
113
121
122
123
124
211
212
221
222
231

Light
Heavy
Others
Railway
Airport
Parking
Terminal
Fir

Pine

Oak

Beech
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Entering and Coding Attribute data

-Easily stored in tabular form - called tabular data
-Different data types stored in different table

-Number of column extended by linking another table
using common assess key or entering data to same table.

-Table design independent of geometric data type

1 123 22.67 0914
2 111 1.45 0916
321 46.80 0923
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Linking Digital Map and Attribute Information

Digital map database

|
" .| ==
EE - u = 589 | i i,
- -
|
..I e
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Land Register

44/ 113 Jerry Peter 1/1099, Anthill..

Linking by ID
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Linking Digital Map and Attribute Information

185 2

1 559 A 44/110
2 600 C 44/95
3 610 B 44/121
4 156 D 44/81
S 642 C 44/78

Linking by geometry
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Database and Database Management System
Database :

-Sets of collection of information
-files structured by DBMS and accessed through it

-DBMS located between the physical storage and the user.
e

Users

be—

DBMS

}

Files
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Database and Database Management System
DBMS :

- Software package for storage, manipulation,
retrieval of data from a database.

-To handle complex task of multiple files

-Located between the physical storage and
the user.

Database



Relational Database structure

234 44/110 ‘

256

44/50

298

44/19

44/50

44/110

John

6400

33 ...

44/19
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Relational Database structure
-Geographical object in a record

-Attribute In in a set of fields
-Three basic attributes
primary key
relational join
normal forms
-most frequently used for attribute data

-simple, flexible structures
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Relational Database structure

-search time is longer

-collection of large number of table for complex
relationships

-Stores single value for each cell



Exercise

. Database file handling
. Selection

. Preparation of Sub-Set
. Database query

. Calculation
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1.Database file handling

1.1 Loading existing data

1.2 Creating point data

1.3 Input / Edit attribute data
1.4 Join tables

1.5 Link tables
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1.1 Loaded existing data

-Double click the g@.{ icon or go to Menu Start menu

-Click at Add Theme icon

-Select theme name “district.shp” then click OK.

i1 add Theme x|

Directony; | d:“trainingshealth-gis 0K

= d* - C
ancel
[= training

B province.shp

= health-giz

e Directories
— — " Libraries

Drata Source Types: Dirives:
| Feature Data Source | | d: |




-Open attribute table of

theme “District.shp”

Activate theme
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i ArcWiew GIS 3.2a

Eile Edit “iew TIhems

pe=fnalvziz  Suface  Graphics ®Toole  “Window Help
Eai FFEE FED
ORI RIS [FSIT] Gl s imw_

I i Yiewl

.....

> ] Ditrictshp o
[ |

#! Attributes of District.shp
Lz S M
13 1312 i Vilabouri 1765107473680 17ER 107§ 5
13 1311 i Haibourn 295345602 353 296946 5
Palygon 13 1313 Atsaphon 1452316064 ED2 1452 316 5
Palygon 13 1305 | Xepon 2266782030519 22667821 5
Palygon 13 1302 i Duthournphon 1082417234 996 10824171 5
Palygon 13 1315 Phalanx<ai 33307R585. 390 993077 i 5 .
Falygon 13 1303 § atzaphangthong YO0337733.695 ¥00933i 5 CIICk
Palygon 13 1304 : Phin AT 2454212 37212515
Palygon 13 1301 i Khanthabour B31611273.958 B31.E11i5
Palygon 13 1303 i Champhon 10437587393.065 1049759 57
Palygon 13 1306 i Mong 1700596032 260 1700596 5
| Palyaan 13 1310 Xonboun 1205353535145 12059608 5
4] | 3




1.2 Creating point data

- Click at Table icon then click Add button
- Select a table file name “dh.dbf”

Click
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ak.

File M ame: Directaries:
| dh.dbf d:\trainingkhealth-gis
(= d -
By district. dbf [= training
B province. dof &= health-giz
Lizt Filez of Type: Dirives:
| dBASE [* dbf) -l | d =]

Cancel
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- Activate View window
- Go to View menu and select Add Event Theme
- Choose table name*“dh.dbf” and X,Y coordinate

i Add E?Enl: Theme EI

Theme Analysiz  Surface  Graphice  ®Tool: Window  H

Eroperties. . |,z§| ..... B ” ” Wa%‘” WE
&dd Theme. .. Cul+T [ . T Table: BN
Geocode Addiesses. . e '| |q | =

Add Event Theme. ..

Themes [F " figld: | _coord

LLayomt, .

TOC Shyle... ;I

|
Mew Theme. .. J % field: | ¥ coord ‘K
Themes [

] -

QE. Cancel |




- Go to Theme menu and select Convert to Shapefile
- Navigate the working directory and set a new name

“district_hospital” and click OK

i Convert Dh.dbf

File M arne;

fnalyzis  Surface  Graphics

Broperties...

¢ GtartEdting
= Save Edits
Save Edits Ss...

Corrvert to Shapefile...

Convert ba Grid...
! Sawe [Mata Set...

| digtrict_hospital. shp

Directaories:
d:htraininghhealth-gis

= d
[=> training

= health-giz

Drrives:

|
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Cancel

x|
ak |
__ Cercl |

e

& ¥iewl

7 Ditrict_hospitalshp
L ]

‘| | Dhadbi

1l




1.3 Input / Edit attribute data

Open table of “District_hospital.shp”

In Table menu, select Start Editing

Click at field name “Dcode”
Then click Sort Ascending button

18]
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GIS 3.2a

Field %Tools ‘window Help

Eroperties. ..

2] (] (H]X]]

LChart...
Start Editing
Save Editz

| Save Editz bs.

: FEind.. Chil+F
Cluem... Ctrl+0
Framaote
Jmir [Ctrl+]

elected

INES(

B

#! Attributes of District_hospital.shp

Shape | “oode Yhamee ode Dname #_coord ' _coord

i Paint 1301048 THAHEIR 1301 § KHANTHABOURI 104.75395 16.54684

"| Point 113020010 CHOMPHET 1302 § AJTHOMPOME 105.00039 16.67178
Paint 1303025 DONGHEM TaAl 1303 ATSAPHAMGTHOMG 10528223 16.70487
Paint 1304002 § PAS Dby 1304 i PHOME 106.01075 16.53364
Paint 1305157 QUDOMSOUE, 1305 SEPOMH 106. 20286 16.71285
Paint 1306001 { THESABAMNH 1306 | MANGMOI 10649747 16.37082
Paint 1307036 | THASALAKHARM 1307 § THAPANTHOMG 10573329 15.97548
Paint 1308011 § THOMNGSIMOUANG 1308 SONGEHOM 10520684 16.23608
Paint 1309126 ¢ KEMGKOEDONG 1309 | CHAMPHOME 105.18635 16.45377
Paint 1310029 § MONSAVANG 1310 SONBOULY 10533387 16.38343
Paoint 1311002 ¢ KEMGEABAD TAl 1311 ¢ SavBOULY 104. 74577 16.80611
Paint 1312097 | POUNGPO 1312 P vILABOULY 10593938 16.83001
Paint 1313001 { HAT DOK KEO 1313 ATSAPHOME 10531267 16.90038
Paint 1301137 { VEURNEHOUM 1314 SAYPHOUTHOMG 105.00187 16. 265490
Paint 1303070 KALOMNG MUA 1315 PHALAMNSAY 105 52025 16.65323
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- Select Edit button and click in Dname at Dcode = 1302 e

- Type new Dname to “OUTHOUMPHONE”
rr——— =

Tool: window Help
=]

elected
|
Ed I t b Utto n i attributes of District_hospital.shp
Shape | Ycode Yhamee Dcode Drname #_coord Y'_coord
i FPoint 1301048 THAHEIR 1301 § KHAMTHABOURI 104, 75395 1654684 1 &
"| Point 1302010 CHOMPHET 1302 OUTHOUMPHOME 10500099 1667178
Foint 12303025 DOMGHEMN TaAl 1303 ATSAPHANGTHOMG 1058, 28223 16. 70487
Point 1304002 f PAS Okdsty 1304 ¢ PHOME 10601075 16.53364
Point 12305157 ¢ QUDOMSOLUE 1305 SEPOMH 106 20286 16.71285
Foint 1306007 : THESABAMH 1306 ¢ MARGMOI 10649747 1627082
FPoint 1307036 f THASALAKHARM 1307 ¢ THAPANTHOMG 106 73329 1597548
Paoint 1308011 § THOMGSIMOUARNG 1308 ; SONGKHON 106 20684 1623608
Point 309126 KEMGEOKDOMNG 1309 : CHAMPHORE 10518635 16. 45377
Foint 1210023 NOMSAVANG 1310 SOMBOULY 10633887 16.283473
Point 1311002 : KEMGEABAD TAI 1311 SAYBOULY 104 74577 1680611
Point 11212097 : POUMGPO 132 vILABOULY 10593938 16.88001
Foint 112313007 : HAT DOKE EEQ 1313 ATSAPHONE 106 31267 1690038
FPoint 123017137 : WEURMNEKHOUM 1314 SAYPHOUTHOMG 10600187 1E. 26530
Point 12303070 KALOMG MUA 1315 PHALAMNSAY 1068 52025 16.65923
1] |+




- Select Add Field in Edit menu

- Select Name and Type of Field

- Click OK

i Arciew GIS 3.2a

File Table Field %Tool

[ELik; [Chrl+ :
[Eopy [Ckrl+E
Fazte [l el
UndoEdit  ChlZ F
Redo Edit  Chl+y

! Field Definition

Add EiE|l:|...
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F Add Becord  Chil+4,

Mame: | Peode ak.
Type: | Number x| Cancel
findow _Help \ Calculate widh 3
[x [In] €]

i 2 Field Calculator X| . .
| Fields Type Fequests = CIICk at PCOde fleld name
' & Numb : -

Vesd] - st : 1 - Select Calculate button

[Whnamee] - . '-.- & & i

(Deod] ® -- —L | - In Field Calculator window

[Dname] / GAEG4 N

d E7178 -
ﬁ:zzz:d} ;I := ;I T04a7 type “13” then CIICk OK
53364
] = : -
71285 ! ArcYiew GIS 3.2a

13] = g;gis File Edi Field %Took wir
! Cancel | :23508 E Bropertiez. . E
d 45377 Chart...

: : : 3838 Step Editing

- Save Edits and Stop Editing in Table menu

Save Edits Az




1.4 Join tables

Select Table icon
Click Add button
Select a table file
name “soc-eco.dbf”

Click OK

a

i social-eco.dbf

1 Untitled =]

Mew |

Open | aad
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- Cancel

X
oK |
e

oot Ldtar | Wb M Ana A Sbaed A A5 | Fin | Anab | Famab
1301 E1144: 16543: 5472 FH7 11822 71980 3553 3E449
1302 25973 9708 ar 11450 7E33: 493681 23932 25426
1303 16486 fl==h 274 1020¢ VEE2: 48BE2: 23397 251E6
1304 10385 5648 a0 45¢ 5435: 37704 ¢ 18630 19014
1305 7333 6186 13 32 4943 ZVERT | 137FE 13889
1306 173 2729 10 71 2ERE: 1E1R0: @158 2002
1307 vard 3242 104 20 3242 23330 11373 11957
1308 455331 12818 442 435 113131 YIM6 36249 3E9EE
1309 35634 13806 323 1815 13585 85381 41131 44250
1310 11508 4334 35 110¢ 4334 34167 16346 17821
1311 20739 B326 G0 3¢ BOBO: 36361 17753 18602
1312 EE35 iy e 24 2003913 242981 12041 12267
1313 14735 £330 41 40¢ E390: 40290 19798 20492

File: Marne: Directories:
| zoc_eco.dbf d:\traininghhealth-gis
[ dh.dor = = dr =
B district. dbf [ taining
harts [ district_hospital. dbf &= health-gis
@ B province.dbf
Layouts
Seipts | List Files of Type: Drives:
| dBASE [+ dbf) E3| [d E3



i o Geoinformatics Center
-Open attribute table of theme “District.shp”

-Click Dcode filed name of “Soc-eco.dbf” then Click Dcode filed
name of “District.dbf”

)

& socialPeco.dbf
: At | i A Ame A Shbef An| A5 | Fe | Ml Ffamab

\‘Lﬁl;ﬂ,/ E1144 165431  B472 FRE7 118221 71980+ 3863 J6449: &
1302 28973 9702 ar 1145: FE33: 493601 23932 28426
1303 16486 FBIY 274 10208 FBEZ: 485621 233497 25165
1304 10385 AE48 30 45: ha93: 37704 18690 19014
1305 7393 E186 19 32 4943F 27ER1: 13772 13883
1306 1731 2729 10 7i 26B8: 1B160F @163 2002
1307 Fard 3242 104 24 2427 232308 11373 11957
1308 455733 12818 442 435 118138 7351 36249 JB3EE
1309 38634 13806 323 1815 13685 85381 41131 44250
130 11508 49384 35 110 4384: 24167 16346 17821
1311 20733 E326 B0 919 BOBO: 26361: 17759 18602
132 BE35 3913 24 240 3913F 24293 12041 12267
133 14735 B3390 4 40¢ B390: 40290 19738 204520
# Attributes ufnistriﬁp |
e s LAz 57 Sip A
Palygon 131 S 12 | Vilshour 1765107479680 =]
= | Palygon 13 1317 § =aibouri 895345602959
Palpgon 13 1213 | Atzaphaon 1452316064, 602
Palyoon 13 1305 § Xepon 22B6VE2030.519
Palyoon 13 1302 | Outhoumphon 1082417234 996
Palygon 13 1315 Phalan=ai 99807E585.390
Palpgon 13 1203 § Atzaphangthong 0093738695
Polygon 13 1304 : Phin 372124542212 T
Palyoon 13 1307 § Khanthabouri BA1611273.953
Palygon 13 1309 i Charmphon 1049758789 065
Paolygon 13 1306 Mong 1700596082, 260 -
i | ]

- To join two table , Click Join button
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- Check attribute table of “District.shp” with new joined table

#2 Attributes of District.shp
: T D e y

13 132 i Vilabour 1765107473680 1765107 | SAMAMMARHET G635 3913 24 241 33~

13 1317 § =aibour 335345602 959 395946 | SAVAMMAKHET 20739 G326 GO 13 GBOGO

13 1313 Atzaphan 1452316064 602 1452 316§ SAMAMMARHET 14735 G390 4 40: 6330

13 1305 § ®epon Z2BEFE2030.519 2266.782 | SAMAMMARHET ¥393 G186 19 321 4343

13 1302 i Outhourmphan 1082417234.396 1082 417§ SAMAMMARHET 284973 3708 ar 1145 Y633

13 1315 Phalanxai 938076585.330 938 077 | SAVAMMAKHET

13 1303 | Atzaphangthong FO0337733.695 F00.938 | SAVAMMAKHET 16436 FB37 274 10208 7BGEZ

13 1304 i Phin 3724542 12 FAF2 1251 SANMAMMARHET 10335 BE4G a0 451 5453

13 1307 | Ehanthabour BE1611273.958 BE1.611 | SAVAMMAKHET G1144 16643 B472 a7 11822

13 1303 i Champhon 1043758733.065 1049.753 | SAMAMMALHET 35634 13806 323 1815 13585

13 1306 i Mong 1700536082 260 1700.536 § SAMAMMALHET 1731 2729 10 71 2BEE

13 1310 ®onbaurn 1205953535.145 1205960 § SAMAMMARLHET 11508 4334 il 1105 4534

13 1314 § ®aiphouthong 4548322663.925 454 823 F SAVAMMAKHET

13 1308 i Songkhon 1635816533, 466 1635817 | SAMAMMARHET 45533 12818 a4 435§ 11813

13 1307 i Thapangthong 2115852184 356 2115.852 | SAMAMMARHET T4 J242 104 240 32421
4 | [

i Arc¥iew GIS 3.3

=~ - 1 1 Eile  Edit Field  window
- To cancel joined table, click Remove All Joins In & & 55

l— Chart. .
Table Menu N ——— Start Editing
i Save Edite
New Save Edite s,
Eind... Chil+F
@ Querny... Chl+0
Eromote
E Join [Strled
176510 Bemove All Joins

Lirik

Eemave &l Links




1.5 Link tables
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Linking option is used In case of one-to-many relationship.
For example we want to link to database of district boundary to
village coverage weather to know the village information by district.

-Add table of “District.shp” and “Village.shp”

#2. Attributes of District.shp

Vs Leazanz Sz L7 A Fhaane
T3 1312 Vilabouri 1765107479, 560 765,107 | SAVAHNAKHET
K 1311 Saiboun BAha4GRD G5 B G4 T SAVANNAKHET
73 133" Atsaphon T 4RI BN Fil iR SR SAVANNAKHET
K 1305 Kepon /e b SORE TAZ T SAVANNAKHET
K 7305 Hithoumphon B4 7534 A T8 477 SAVANNAKHET
73 318" Bhalansi SARN7ERGE 350 BAR077 | GAVANNAKHET
K 130037 Atsaphanathong NG 796 Bah 70 538 | SAVANNAKHET
K T304 Fhin AR 7S 5R T GAVANNAKHET
73 T30 Ehanthaboun EETETT573 558 EATET | SAVANNAKHET
K 1308 Champhon Ti4G75E7E s 148 758 SAVANNAKHET
13 1306 Nong 1 7ONRAENS? 28N 1700 RAE : SAVARMAKHET H
73 T3 Konbo B 1
2 2 e e
13 1308 Songkf Mooy 301001 13017 131 HOUARANG 18475300 1a51000~|'
K| Print  HAO02 : 1801 1 14 NAMED =l
= | Print  HAO03: 1300 13 BELNGTHALE Teisednn i
| [ Faint HEO0E Y TE0TYE THASAND GRAI TR47AE00 . TE43E;
Print  HaG06 : 1401 ¢ 131 THASAND NOY TRAFRSO0 TS
Print  HA007 £ 1300 ;131 PaKED TR473500 T TEAE L
Puint  H A 008 : 1801 & 131 TONPHELING TRAE3RO0 BRI
Print  HATI008: 1301 13 LaONGAM TR4E7EON . TE45E0;
Print a0 1301 ¢ 131 KHOMEEHN TR4ETEOD . a4
Print  HAOHT £ 1801+ 13 NACHALID TRAE0HGE AR
Print  HA0TH2: 1300 ¢ 13 DONGDAMDLANE TR4E7E00 B4R
Print  Ha013: 13011 13 GHANG TR4ERI00 T TE4Eg0;
Print HAOH4: 1401 ;13 PHOG] TRAEREN 4R
Print  HAIOHE: 1301 13 KHELAKAAOKAT TR4BEA00 . TE44A00
Print  HatB: 1401 ;131 NONGROM TR4EAE00 T T340
E'.iint TEHE 7 TE T DONGRANE TRAE5A 184440{71

-Click on field name “Dcode”
of Village’s table first

-Then click field name
“Dcode” of district’s table

Field =Toalk

Eroperties. ..

LChart. ..

Start Editing
Sawe Edits
Save Edits A,

Eind...
Luery.
Fromote

- Select “Link”
in Table menu

Ctrl+F
Crl+

Chrl+J
Eemove &l Joins

Bemowe alllLinles
Refresh

Jain




= %= Lz Sz @ Sk

13 1301 : khanthabouri ES1611273.955 ES1.611 : SAVANMNAKHET =
13 1302} Duthoumphon 1082417234 996 1082 417 | SAVANMAKHET

13 1303 : Atzaphangthong 00937793695 700,935 SAVANMNARHET

13 1304} Phin 3372124542 12 3372125 SAVANMAKHET

13 1305 : Xepon 22BE7E2030.519 2266752 | SAVANMAKHET

13 130E | Mong 1700536082 250 1700596 | SAVANMAKHET

13 1307 : Thapangthong 2115852184956 2115852 | SAVANMAKHET

13 1308 | Songhkhon 1630516539 466 1E35 817 | SAVANMAKHET

13 1309 : Champhan 1049758739.065 1049759 SaVANMAKHET

13 1310} Xonbouri 1205959535 145 1205960 : SAVAMMAKHET

13 1311 & Haibouri 995945602 959 995,946 ¢ SAVANMNARHET

13 1312 Wilabouri 17ER107473.630 17ER 107 | SAVANMAKHET

13 13131 Abzaphon 1452316064602 1452 36 | SAVANMNAKHET —
13 1314 | ®aiphouthong 454822663 925 454 823

SAVANNAKHET
o j
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Two tables are linked together

then we can select a record of district
-Click Dcode = 1306 in district’s table
-Automatically select to records of
Village which use same district’s code

ﬂ Willage.shp -
[
] Ditrictshp
1 -
71 Attributes of Yillage.shp
Yraamas
Paint 1306005 1306 13 PALOGMAM 18680200 1 E2EI3EI[;|
Point 1306004 ¢ 1306 13: 0l 186832000 181780C
Point 1306003 : 1306 13 TAMHTIE 18620200 18718600
Paint 1306008 1306 13: La0l 18650000 1830700
Point 1306002 ¢ 1306 13 PALOGEOE. 18673800 1820700
Point 1306006 1306 13 PALOGBOLUAK 18673500 1819200
Paint  1306010% 1306 13 SALOY MA| 18655300 184 ED[J
Point 1306017 ¢ 1306 13 SALOY KAD 18658200 1831400
Point 1306007 ¢ 1306 13 CHAM 18654800 1831900
Paint 1306009 1306 13 SANGPHOU 18654600 183040C
Paint 1306014 ¢ 1306 13: HOUE 18659500 181200
Point 1306015 1306 13 MALOMG KAl 18653200 182650(
Point 11306016 1306 13 LADER 18663500 1828000
Paint 1306012 1306 13 TAMLOUAMG 18E5EE00 18:2930C
Point 1306018 1306 13: SEME 18EEE400 1827300
1306019 1306 13 ASINGSALI 18668500

F'Tint

1 szsnnl(ﬂ

Number of villages fall in Nong’s district

File Edit Table Field #Toolz “wWindow
[
[ Hpt[ 1431 selected




2. Selection

2.1 ldentify features
2.2 Select features
2.3 Select records

2.4 Select by themes
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2.1 ldentify features

-Activate theme name “District.shp”
-Click Identify button then click on a feature of district theme

i ArcYiew GIS 3.2a

Eile Edit Yiew ITheme Analysiz Swface Graphice ®Tools  Mindow Help

RIS @

& 2] ] [£]

( QT)_. BRI =T ] G[F] Scale 1[ZE17.617 1
N
Mew | Open | Add |
=]
vistrict, shp - Khanthabour Shape
Prode
[icode
Ciname Khanthabouri
Sg_m GE1611273.958
Sg_km 621,611
Prame SAVAMMARHET
Liter_pes 47157
. . L?ter no 15510
All information Liervode &
. .. > el 4T
Included joined data vl ungis” =54
ivir
R ain 5
Wiater othe | 103
“Wiater noda ;@ 2
Toilet_mod 154
1| Taoilet dmy 280
1| Toilet_nor 4308 -
Clear Ceartll | [ | ]
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2.2 Select features

-Click Select Feature button  [77]
-Clicking on a feature

of district theme
-Open table of district.shp
-Click Promote button

« Ditrictzhp 1=

to make the selected |
record shows on top.

Fhames
[ 5avANNAKHET E473: 11458 ] 16 J68 971: 2186 20|~
SANMANMAKHET BE35: 12727 2 24 | 14471 2428 2
SANMANMAKHET 20733 12885 2 G0 474 ara3: Zh4e 3
SANMANMAKHET 14735 17562 1 41 150 a7 455
SANMANMAKHET 7393 20956 4 19 106 Baz2i 5349 E
SANMANMAKHET 28973 23080 G ar 1676 B711 07 1
SANMANMAKHET 9851 : 10723 1 287 344 1680¢ 1673 2
SANMANMAKHET 10547 20052 K] a1 731 1124¢ 3380 3
SANMANMAKHET 47157 : 15510 4: 5350 1479 b364 179 5
SANMANMAKHET 25634 ¢ 334499 K] 323 71z 9360: 2133 3
ﬁ'ln'.ﬂxhlhl.ﬂxVLII:T 171 11 401 in I hpin] 277 20 ] ﬁ
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2.3 Select records

- (c - - 7y #4 Attributes of Districk.shp
-Activate “District.shp” Table [oel fw Dian: S S
Fleen 13 1307 | Khanthaboui BE1611273.950 BE1E1 -
. [ E 1302 Duthaumphon {5541 7534, 595 TiEs 417
-C I IC k Se I ect b utton S 1 1505 1 Ateaphanathong SHOGA7 756 Go5 St a5
[ E 1504 ¢ Ehin 3751 545D 912 3375195
Cl . k d [ E T30 Sepon e 7 o001 S5EE 750
- Falygon 13 T8 Hong {7 00B5E062. 260 1700 556
I C I n g O n recor S Faolygon 13 1308 Thapangthong 2115852184956 2115852
Falygon E 1308 Songkhan {35 BE. 46k e a7
- — Falygon E 1305 Champhan 145755755, 05 1045, 753
Wh I Ch DCOde - 130 1to Falygon E 1510 Ranbaur T SESESEE, 1 45 1508, 350
Elil ..... 17 b s e [ QOFRaARChT GFRG [m]u] = ﬂdﬂ'ﬁ

1305. Hold SHIFT key

to select many records

] Ditrictshp =

-Try a set of Selection Tool

'
(=i

L4]
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2.4 Select by themes

_

Analpsis  Surface  Graphics  ®Tools  Window  Help

-Select district name ot L = :

“Khanthabouri™

Carvert b Shapefile.

- Corvert bo Grid... ¥ "‘riiage-s"'P =
-Add theme®Village.shp” o R
it Legend...

_GO to theme menU, Hide/Show Legend

Ee-match Sddresses.

Select By Theme e G

Eemove Owerlapping Labels

Eonvert Wverlapping Labelz Eiilsl

-Activate “Village” theme = .

. . Ouery. Chrl+03 =
-Choose input options as ~ EE=mm= =
Create Buffers. . 1 Attributes of District.shp
Clear Selected Eeatures Shame | St Hoowts endana Sip N
be I OW Edit Theme Expression,.. Puolygon 13 13071 : Khanthabour B81611273.953 ;I
Puolygon 13 1302 ¢ Outhoumphion 1082417234, 996 ‘
&} select By Theme EI = 12 1AM | ke sk seabemn INNa377O0 COR

Select features of active themes that -Then CIiCk NeW Set
s | | -Open table of “Village” and check

e _ — : number of villages within the district
Driztrict. zhp - elect from S et
| EIREAEAE IEE

| B8 of| 1431 selected
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3. Preparation of Subset

3.1 Creating subset shapefiles
3.2 Creating subset databasefiles
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3.1 Creating subset shapefiles

Once villages of Khanthabouri have been selected, we want the
selection into separate shapefile.

- Activate theme “Village.shp” which have been selected

within Khanthabouri district
- Go to Theme menu and select Convert to Shapefile

B ¥iewl
ﬂ Willageshp I=
. pa
_| Districtshp &nalyzis  Suface  Graphics
[ Eroperties. ..
Start Editing
Save Edits

Save Edite ba.

Convert to Shapefile. ..
Convert to Gnid...
Save [Data Set...
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-Navigate the working directory and set a new name

“Vi I I_ktb” and CI iCk OK i Convert Yillage.shp X
File M arme: Directories: oK. |
N

| will_kth.shp d:\trainingshealth-gis
—— = o —

Cancel

|»

[= training

= health-gis

_Add new theme “vill kib” | 7"

on View Window "
E: =]

L4
I

il Viewl

o ill_ktb .shp =
[ ]

ﬂ Village=hp
L

| Ditrictshp

Rl
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3.2 Creating subset databasefiles

This step we will create subset database file of population for
Khanthabouri district.

-Add Theme name “pop95 vill.shp and “district.shp”
-Select Kanthabouri district feature
-Select “pop95_vill” feature within the distict

#2 select By Theme x|
Select features of active themes that
* @&
New Set | ) Popas_wilshp A . s . " - .
- . L " .
the zelected features of Add to Set | L ] - . . ] Y 1
| Districtzhp - . * Tall,
IDigtrict.ShD | Select from Set | I:I ™ . " - | ]
. @  * *,
-
a *T .
- ¥ '.- -
-
Cancel | %, . .
i. ';.l -
[ ] L] r :.-
. " ™
" g
. ® o*
L]
* ",
- - e -
;] * ? - --
. g - .
— L - ﬁ. L ) r - -'-
r o ot o
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- O p e n th e Se I e Cte d cw Ijeld KTook ‘window Help

flose HIEIE]

“Pop95 vill” table -
| zelected
— Save Project ChrlS -
Save Project Az... ! hutes of Popd D — O x
-SeIeCt EXport from N Shana| Moook | Peoda | Foodk Yoamee S Seamatine S
Print. Point 1301077 1301 13 XOGNUA 13 1750 gl
= ) Point 1301078 1301 131 GNANGSOLUNG 138 790 3
FI Ie menu Prit 5 &tup... Point 1301073 1301 13 HOLAY TAl 184 995 4J
Erpot... Foint 1301081 1301 13 KENGHINSOUNG Ed o] 1
Exit |Point 1301082 1301 12 DONGEHAMLOUANG 35 20E
_Choose dBase aS Point 1301083 1301 12 XOKVANG MUA 79 437 2
m Point 1301084 1300 13 XOKMANG TA 97 5ER 2
@ Point 1301005 1301 13 KHAMSAN 143 766 4
f CI - k OK Point 1301085¢ 1301 13} KHOUADAM 33 472 2
EXpOrt Ormat, IC Charts Font 1301093 1301 13 SOMPOY 118 BE3 3
Point 1301100; 1301 13 HAPHO 131 727 3
- - @ Point 1301101 1301 13 PHAKEHA NOY 101 531 2
-NaV|gate to Worklng Layouts Point Aa01102: 1301 131 PHAKKHE, GHA] et 1544 7
= Point 1301103 1301 13 HOME-OUDOM 27 113
. . ’fE.’ Foint 1301104 1301 13 HOUAYPHAI 28 170
dlrectory and Input a neW Scripts <] Point 1301105 1301 13 SOMSAAT 70 57E 2
= Point 1301048, 1301 12! THAHEIR,
Point 1301067 1301 131 SOMSAAT 150 BE7 4
= Point 1301087 . 1301 131 KHAMSAVANG 58 230 1
name, CIICk OK Pont 1301088 1301 13} PHORAY £ 318 1
PTint 13010831 1300 13 KHAMHENG 186 Imn!a 5~
1 »

x
! Enport Table x| File Name: Dlreu:t.n.nes: . K |
| pop35 kb, dbi| d:\rainingshealth-giz

E xport Farmat:

= = = dh - Cancel
= training

&= health-gis

Cancel |

INFO
Drelimited Text

Dirives:

E: ]

L4]
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-Add table “Pop95_ktb.dbf” and open table of “Vill_ktb.shp” theme
-Join two table and save as a new shapefile (Covert to Shapefile)

i} Arc¥iew GIS 3.2a

Eile Edt TIable Field =Toolz MWindow Help

| 0 of | 58 zelected “E]

72 Untitled 1 Attributes of Yill_ktb.shp
o T — iar Vi
Point 1307001 § 1301 13§ HOLAXAMNG 18475300 1851000 ;I
P Attibutes of "-.-"i"_l::_ttl_:5:h|:| Paint 1301002 1301 13§ MARBO 18473300 1345800
@ [ pop95_ktb.dbf Point 1301003 1301 13i BEUNGTHALE 18476400 1846700
Foint  £1301005: 130 13§ THASAND GMAI 18474300 1843500
Point 1301006 1301 13 THASAND NOY 18474200 1842400
Faoint  £1301007 ¢ 130 13 PAKBO 18473300 1833700
Paint 1301008 1301 13 TOMPHEUMG 18483500 1850100
Faoint  £1301003: 130 13§ LAOMNGAM 18487300 1843200
Paoint  £1301010¢ 130 13 KHOMKEM 18487300 1843000
Faoint  £1301017 ¢ 130 13 MACHALID 18430000 1844500
Paoint 1301012 130 13 DOMGDAMDUAME 18487300 1846000
F'rluinr 13013 1:5m 13 GNANG 1R48R30N 1 HdHFII'II'II%J
: e Sy s St
13071001 13 13§ HOUAXAMNG 95 593 #5 28;'
1301002 130 13 NAMBO 129 Ba7 344 34
1301003 13 13{ BEUMGTHALE 74 404 207 19
13070058 1301 13 THASAMO GMAI 150 935 456 47
1301006 130 13§ THASAMD MOY 74 413 202 21
1301007 ¢ 1301 13 PAKBO a5 473 236 23
1307003 : 13 13i TOMPHEUNG G 352 164 18
1307003 1301 13 LAOMGAM BB 300 146 15
1301010:¢ 13 13§ KHOMKEM G2 329 168 16
1301011 ¢ 1301 13 MACHALID 7B 452 233 |
1301012 13 13 DONGDAMDUAME B1 336 161 17 -
AR TEA Zo i ﬁiﬂ
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4. Database query

4.1 Build query expressions
4.2 Database query ( single/ multiple )
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Building a query expression is a powerful way to select features
which fulfill certain conditions.

-Add theme “district.shp”

-Click Query Builder button
-Double click field’s name

and Input an expression

o) | | _(o] x|
Fizldz Walues
e —— .
[Dode] "Charnphon'
nat
[Sgq_m] "Mong'
[5g_km] e "Outhournchaon' ﬂ
[Prame] ﬂ [v Update Valuesz

awrose Y -Click New Set button

Select From Set ‘

- ; -Query district name = khanthaburi
[ [Dname] = "Khanthabour | j Mew St Q




-Query district name = “Xaibouri”

-Then click Add To Set botton

!} District.shp

Fields

[Shape] a EI
o
wrrmasac
i -

"aiphouthong”

"epon'
"onbouri”

W Update Values

[ [D'hame] = “=aibouri' ]

-~ Mew Set |

Add To Set

- Select From Set

i District.shp

Fields

[Shape] - B
[Pcode]
[DZDDdEE]
[Dname] =

[5q_m]

[Sq_km] T
[Phame] ;I

=10f x|
Y aluesz
""ilabour! il
"eaibour

"aiphouthong"!

"Hepon'
"onboun!

v Update Values

[ [Dhame] = "Outhourmphon'] or [Dname] =
"aiphouthong' ]

- Mew Set |

Add To Set

- Select From Set

“nter

logy
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4.2 Database query ( single)

71 District.shp =10J %]

Field=z Yalues

To find districts which has an area [ S [ | R | = B
1 [Deade] 2115.852

< 3,000 Sq.Km.but > 1,000 Sq.Km. [ 7| ek L
| -

[Priarme] ;I v Update Yalues
[ [Sq_km] = 1000 Jand [[Sq_km] < 3000] - Mew Set w
- (14 - - 77
-Activate “district.shp bddToset |
- Select From Set |

-Click Query Builder button.

-Input an expression
([Sg_km] > 1000) and ([Sg_km] < 3000)

Double click in the list of fields,
Operator and Values
-Click New Set
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4.2 Database qguery (multiple )

How to query multiple database tables in the same time?
-Create a new “district” theme which already joined with table
“Soc-eco.dbf” (step 1.4). Save new theme as “Social_dist”
-Add theme “Social_dist” to a View window

-Click Query Builder button. Input an expression
( [Liter] <10000) and ([Water_hh] <=[4000) and ([Elect_hh] <=30)

#2 Attributes of District.shp -0l x|
Fields Yalues
P () [0 A

b I [
Fipe_hh =
e | S (2

[HH] 45 LI

[Pop] j v Update Yalues

[[Litter] < 10000) and [[w ater_hh] <= 4000] and al |
[[Elect_hh] <= 30]

AddToSet |

Select From Set |
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5.Calculation

5.1 Statistic
5.2 Aggregation data
5.3 Statistic



5.1 Statistic

This step we would like to see
statistic information of total
population of attribute table
“Pop95_vill.shp”

-Add table of “Pop95 vill.shp”

-Activate field name “Sumtotpe™: . o we

-Click Field and Statistic

-The statistic information of the
field will be displayed

-Click OK to close the window

Geoinformatics Centet

Asian Institute of Technology

z #Tools  Mindow  Help

Sart Azcending @

1=

Sort Descending u... :
ik
B Create [ndex u-m
| [ry—

[Ealzulate..

«] Fopas_uillshp ;” og P '
; ake-iy

Yraamae St SN SEARVRNTAS

Wb 301001 1301 13 HOUARANG 96 533 5
W 1301002 ¢ 1301 13 MAMBO 129 E27 344
At A301003§ 1301 13! BEUMGTHALE 74 404 207
W 13010058 1301 13§ THASAND GMA| 150 935 456
Wt A301006§ 1301 13 THASAND NOY 74 413 202
W 1301007 ¢ 1301 13 PAKBO a5 473 236
W 301008 1301 13 TOMPHEUNG 67 352 169
Wb 13010098 1301 13 LADMGAM 56 300 146
Wt A301010% 1301 131 KHOMKEN G2 329 168
W A307011 ¢ 1301 13 MACHALID 76 452 233
1301012 1301 13 DONGDAMDUANE £ 336 161
1301014 1301 13 PHOSI 20 128 £4

#} statistics for Sumoftokpe field ﬂ

Surm: BEE4E7 -
Count: 1403

Mean: 403

bl airmurn; 3923
kirirnm: 21

Range: 3902

Yarance: 110023
Standard Deviation; 332

L<]
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5.2 Aggregation data

In the population database we have information for each village
on population, number of population by district
P
-Open attribute table of Pop95_vill.shp KTools Window Help
Sart Azcending |I||| Mﬁ”%”%ﬁﬂ |>~“s-~<| E

-Activate the table and click on field’s name Sort Descending Al0]
“DCOde” Create |ndex
-Select Summarize in Field menu Calculate... Shape| Vit e
e Statistics. . Paint 130101 13 13:P

-Once Summary Table Definition loaded = R R R T AR R
Click Save As to navigate output file’s directory
#! Summary Table Definition x|

Save As. . | | d:\brainingshealth-gis\sumpop_district. dbf oK | _Select Field name “Sum_sumoftotma”
Field: Cancel |

— -Select a method to summarize
Summarnize by: : : —CIiCk add

| Sum =l

| Sumoitotpe =l




-Select others field ; “Sum_Sumoftotfe”
and “Sum_Sumoftotpe”. Click Add
-Click OK to finish aggregations

-1f there are some unnecessary fields

Geoinformatics Center

#! Summary Table Definition ﬂ
Save Az | | d:\brainingshealth-gis\sumpop_district. dbf ok

Field: Cancel

[ Sumototne K =l . Sum_Sumoaftatma -

Summarize by: &I Surn_Sumoftotfe

| Sum =l

have been added. The fields can be deleted

by clicking on those fields and click Delete button.

)

! sumpop_district.dbf

Sy Sy

T 58 22218.0000 22931.0000 45143.0000
1302 a7 23332.0000 25426, 0000 433580000
1303 45 12464, 0000 13337.0000 25807 0000
1304 135 156300000 13074.0000 37704.0000
1305 120 13772.0000 1:38583.0000 276E1.0000
1306 35 2158.0000 2002, 0000 161600000
1307 24 11373.0000 119570000 233300000
1308 142 362490000 2E36E. 0000 732150000
1303 165 41131.0000 44250.0000 55387.0000
1310 37 163450000 17821.0000 341670000
1511 7B 177539.0000 18602, 0000 36361, 0000
1312 112 120410000 122570000 242980000
1313 37 197380000 204320000 40290, 0000
1314 4 13313.0000 13518.0000 26531.0000
1315 ¥a 103330000 11825.0000 227E1.0000

nmml

Svam Syamnoiiits| Snam Sramdiaioe

-l -Add “sumpop_district.dbf”

"« -Try more aggregations fields
i using others method such as

- Average,Minimum,

~ Maximum.etc.

logy



5.3 Calculator

In order to calculate percentage

Field ®Tools

Eroperties...

AT

1 1=

of number of male and female by district
which we have created from the previous steps.-

Chart...

Save Edits
Save Edts bs.

-Activate table name “sumpop_district.dbf”

which we have created from the previous steps.

[Cuk [kl
Capy [+
Fazte [l
Undo Edit  Chl+Z
Redo Edit  Chl+y
Add Eield. ..

Add Becaord  Chil+é,
[Delete Field

elete Fecords

cviewGisaze MO

Table Field ®To™®

-Click Start Editing in Table menu € Field Defindtion x|
-Add two fields name “Percent_M” and “Pecent_F” with “T*I reeent _ -
= T3 T =799 = 1Tatl) - #P=: | Number - Cancel
be in “Number” type, “7” width and “2” decimal places . ——
-Activate on “Percent_M” field name Decimal Flaces: [ 2
-Select Calculate in Field menu 22 Field Calculator =
- Figlds Type Requests
-Input an expression — — : _
__________________________________________ =1 3| {Bum, Bumoftine] C sting : r
el | Percent_i sTiodls Window [5um_Sumoftatpe] " Date .
457149.0000 [=] " T — [Percent_k] !
492580000 [Percent_F] Iy
2823070000 Sort Diezcending - Py ;l
27744.0000 Create [ndex [Percent_k] =
12;152103333 SLummanze. . Sum_SumoftotmaFTE R S a -
o T — j .
FRART nnnn Statishics. —




ﬂnn;ncn«mni;nn f‘ antas

DO the same expreSSIOn to Calculate percentage urn_Surmaftatmal Sur_Sumaftatte | Sum Sumaftatpe| Percent b =R

22218.0000 22331.0000 451439.0000 431
2£3332.0000 25426.0000 43358.0000 43.43

Of number of female population by district 124640000 1333700001 25A01 0000¢ 4831

158630.0000 13014.0000 37704.0000 4357

- . » £ 137720000, 13eeaonon. 27eelooon. 4379
-Activate “Percent_F” field name gisa0000;  BO0Z0000.  16160.0000C 5048
3700 fiszonon Zamnooon. 4875
: 32490000 IIEE00O0 . 7A2150000. 4351
-Click Calculator button Aiatooon;aszsnononesaETooon.  4B17
- # Field Calculator x|
-Input an expression as follow S — N
[Dcode] - &« Number
([Sum_Sumoftotfe] / [Sum_Sumoftotpe]) * 100 T — ¢ sting :
[Sum:Sumoftotfe] " Date

-Click OK e —
[Percent_F] j

mssze
Field ®Tools ‘window Help (T s ¢ (S urn_Sumoftatpe]) * 100 -

Eroperties. . @ i

Cancel

LChart... “m —

Stop Editing

Save Edits

Save Edits As... Sum_Sumoftotma) Sum_Sumoftotfe | Sum_Sumoftotpe | Percent_M | Percent_F

Eind..  CkF BB 222180000 2293100000 451430000 49211 5073

Quew..  Cuk@ g7 enunod;seavcoood;esFsmo00d. anddrETE]

P 59 zagenoon;iEEvoo00; T 2SEnionod: aBd | ETEd -

135 Yecanooo0; iapiao000, drzoanoo0: 43E7ED43 - S e I ect S ave E d ItS IN Tab I e

Jair Cils 1207 iEzano0;TaEER 000 ZreeT o000 as e B0

Biemave &ldoins G gissO000; E00Z0000; T TieienO0od; T BD4El T 4gEl

Lirk g4 Tigzooon;Tissrooonl U Z33nooon’aersl B2 menu

L 142 36249.0000 3E9E6.0000 73215.0000 43.51 50.43

1650 41131.0000; 442500000  85391.0000% 4817 5183 'C“Ck Sto Edltln
Refresh 971 16346.0000;  17821.00007  34167.0000] 4784 5216 p g

1311 7E 17769.0000 18E02.0000 3E361.0000 43.84 51.1E
1312 112 12041.0000 122570000 24298.0000 49 BE 50.44
1313 7 19735.0000 204320000 40230.0000 4314 50086
1314 4 13313.0000 13518.0000 26831.0000 49.52 5035
1315 3 10933.0000 11828.0000 22761.0000 4303 51.97




